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University of Southern California 
Marshall Information Services 

Determine Breakeven Price Using Excel 
- Using Goal Seek, Data Tables, Vlookup & Charts 

 
This guide covers how to determine breakeven price (or units) using the following tools: 
 

 Use Goal Seek to Determine Breakeven Price (or Units). 

 Build a Model to Determine Breakeven Price (or Units) using a Breakeven Calculation. 

 Generate Multiple Breakeven Prices for Various Units using a One Variable Data Table. 

 Use Vlookup() to Adjust Cost Per Unit as the Number of Units Changes. 

 Create a Breakeven Chart 
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Breakeven Analysis Using Goal Seek 

Breakeven is the point where your profit equals zero or in other words, when Total Sales – Total Costs = 0. 
It is often helpful in determining the price you should charge for a new product or the number of units you must sell to 
breakeven. In these two exercises, we wish build a spreadsheet that shows what the Profit will be if we vary Price and 
Units Sold.  We will then use Goal Seek to set Profit to 0 by changing either Price or Units Sold. 
 
1. Create the "Breakeven_GoalSeek" sheet shown below. 

Given: 

 Cost Per Unit is $15 (i.e. it costs us $15 to make each unit). 

 Fixed Costs for the time period we are producing our units: $2000 
Formulas: 

 Revenue:  Price * Units Sold    =B5*B6 

 Variable Cost: Cost Per Unit * Units Sold  =B8*B6 

 Total Costs:  Variable Cost + Fixed Cost  =B9+B10 

 Profit:   Revenue – Total Costs   =B7-B11 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Type some test values into Price (B5) and Units Sold (B6).  Profit should update as you vary B5 & B6.  Our goal is to 
keep one of these two cells constant and adjust the other until Profit goes to zero. 

 
 
Using Goal Seek to Set Profit to Zero 
The good news is that you don't have to keep typing in trial numbers until you arrive at one that sets Profit to zero; Goal 
Seek can do the algebra and find either the Price or Units Sold that will set Profit to zero for us.   Note that for Goal Seek 
to accomplish this, there must be a mathematical relationship between Profit and Units Sold and Price. In other words, 
Profit must be a formula cell and Price and Units Sold must be data cells that are either directly or directly referenced by 
the Profit formula.  If manually changing either Price or Units Sold does not change Profit then you cannot use Goal Seek. 
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Goal Seek Exercise 1:  Determine Breakeven Price if we Sell 100 Units  
If we produce (and sell) 100 units, what must price be to break even?   
 
a. In Price (B5) type 0 and in Units Sold (B6) type 100. 
b. Click in cell B12. 
c. From the menu click "Data" – "What if Analysis – Goal Seek…" 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Goal Seek Exercise 2:  Determine Breakeven Units if Price is set at $20  
If price is set at $20, how many units must we sell to break even? 
 
a. In Price (B5) type 20 and in Units Sold (B6) type 10 (or some other number). 
b. Click in cell B12. 
c. From the menu click "Data" – "What if Analysis – Goal Seek…" 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

d. Set the following: 
Set Cell  B12 
To Value  0 
By changing cell  B5  

e. Click "OK". 
 
At 100 Units you must set the 
Price to $35 to break even. 

d. Set the following: 
Set Cell  B12 
To Value  0 
By changing cell  B6  

e. Click "OK". 
 
At a price of $20 you must 
sell 400 units to break even. 
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Calculate Multiple Breakeven Prices – One Variable Data Table 

In the previous exercises we determined a breakeven price based on a 100 units sold.  In this section we will look at how 
to create a table of breakeven prices for various numbers of units sold.  Specifically, we wish to build the table below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

About using a One Variable Data Table to Return Breakeven Prices 
To build our table of breakeven prices, we can no longer use Goal Seek; it can only return a single answer for profit and 
can only vary a single cell.  We cannot use Solver either.  While Solver can vary multiple cells, it too can only produce a 
single answer.   
 
The solution we will use is a One-Variable Data Table.  It is designed to run multiple variables through an equation to 
produce a table of results.  However, it does not have the algebraic capabilities that Goal Seek and Solver do –  data 
tables will run the variables you give them through an equation to return whatever the results turn out to be, but you 
cannot tell it what you want those results to be.  Fortunately, we can get around this limitation using some simple 
algebra: 
 
a. We know that: Profit = Price * Units – Fixed Costs – Variable Costs 
b. We know that we want profit to be zero. 
c. All we have to do is solve the equation for Price (or Units depending on what you are solving for) and set Profit to 

zero.  Because profit is zero in our equation, Price (or Units) is forced to return a number that makes profit equal 
zero. 

 
See the next page on how the Price breakeven and Units breakeven formulas are derived. 
 
 
 
 

We wish to 
produce a list 
of breakeven 
Prices for the 
Units listed. 
For example, 
at 300 Units 
the breakeven 
price is 
$21.67. 
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Breakeven Equations for Price and Units 

The breakeven point is where you there is no profit and no loss.  In other words, profit equals zero.   The calculations 
below show you how to get breakeven Price and breakeven Units. 
 
 

Equation for Breakeven Price 
Our profit is:  Gross – Total Costs   or more specifically for our example: 
 
 
We know breakeven occurs when Profit goes to zero so we will move Fixed Costs to the left and eliminate Profit by 
setting it to zero: 
 
 
Multiplying through by -1: 

 
 

Dividing both sides by Units: 
 
 
 
 
Units cancel in the first part leaving the equation for getting the breakeven price at: 
 
 
 
 
 
 
 

Equation for Breakeven Units 
Profit is:  Gross – Total Costs   or more specifically for our example: 
 
 
We know breakeven occurs when Profit goes to zero so we will move Fixed Costs to the left and eliminate Profit from 
the equation by setting it to zero: 
 
 
 
Simplifying 
 
 
Solving for Units, the equation to get breakeven for units is: 

  
  
 
 
 
 
 

  
  

Equation for 
Breakeven Units 𝑼𝒏𝒊𝒕𝒔 =  

𝑭𝒊𝒙𝒆𝒅 𝑪𝒐𝒔𝒕𝒔

(𝑷𝒓𝒊𝒄𝒆 − 𝑽𝒂𝒓𝒊𝒂𝒃𝒍𝒆 𝑪𝒐𝒔𝒕 𝑷𝒆𝒓 𝑼𝒏𝒊𝒕)
 

𝐹𝑖𝑥𝑒𝑑 𝐶𝑜𝑠𝑡𝑠 = 𝑈𝑛𝑖𝑡𝑠 ( 𝑃𝑟𝑖𝑐𝑒 − 𝑉𝑎𝑟𝑖𝑎𝑏𝑙𝑒 𝐶𝑜𝑠𝑡 𝑃𝑒𝑟 𝑈𝑛𝑖𝑡) 

𝐹𝑖𝑥𝑒𝑑 𝐶𝑜𝑠𝑡𝑠 = 𝑃𝑟𝑖𝑐𝑒 ∗  𝑈𝑛𝑖𝑡𝑠 −  𝑉𝑎𝑟𝑖𝑎𝑏𝑙𝑒 𝐶𝑜𝑠𝑡 𝑃𝑒𝑟 𝑈𝑛𝑖𝑡 * Units 

𝑃𝑟𝑜𝑓𝑖𝑡 = 𝑃𝑟𝑖𝑐𝑒 ∗ 𝑈𝑛𝑖𝑡𝑠 − 𝑉𝑎𝑟𝑖𝑎𝑏𝑙𝑒 𝐶𝑜𝑠𝑡 𝑃𝑒𝑟 𝑈𝑛𝑖𝑡 ∗ 𝑈𝑛𝑖𝑡𝑠 − 𝐹𝑖𝑥𝑒𝑑 𝐶𝑜𝑠𝑡𝑠 

Equation for 
Breakeven Price 

𝑃𝑟𝑜𝑓𝑖𝑡 = 𝑃𝑟𝑖𝑐𝑒 ∗ 𝑈𝑛𝑖𝑡𝑠 − 𝑉𝑎𝑟𝑖𝑎𝑏𝑙𝑒 𝐶𝑜𝑠𝑡 𝑃𝑒𝑟 𝑈𝑛𝑖𝑡 ∗ 𝑈𝑛𝑖𝑡𝑠 − 𝐹𝑖𝑥𝑒𝑑 𝐶𝑜𝑠𝑡𝑠 

−𝑃𝑟𝑖𝑐𝑒 ∗ 𝑈𝑛𝑖𝑡𝑠 =  −𝑉𝑎𝑟𝑖𝑎𝑏𝑙𝑒 𝐶𝑜𝑠𝑡 𝑃𝑒𝑟 𝑈𝑛𝑖𝑡 ∗ 𝑈𝑛𝑖𝑡𝑠 − 𝐹𝑖𝑥𝑒𝑑 𝐶𝑜𝑠𝑡𝑠 

𝑃𝑟𝑖𝑐𝑒 ∗ 𝑈𝑛𝑖𝑡𝑠 =  𝑉𝑎𝑟𝑖𝑎𝑏𝑙𝑒 𝐶𝑜𝑠𝑡 𝑃𝑒𝑟 𝑈𝑛𝑖𝑡 ∗ 𝑈𝑛𝑖𝑡𝑠 + 𝐹𝑖𝑥𝑒𝑑 𝐶𝑜𝑠𝑡𝑠 

𝑷𝒓𝒊𝒄𝒆 = 𝑽𝒂𝒓𝒊𝒂𝒃𝒍𝒆 𝑪𝒐𝒔𝒕 𝑷𝒆𝒓 𝑼𝒏𝒊𝒕 +  
𝑭𝒊𝒙𝒆𝒅 𝑪𝒐𝒔𝒕𝒔

𝑼𝒏𝒊𝒕𝒔
  

𝑃𝑟𝑖𝑐𝑒 =
𝑉𝑎𝑟𝑖𝑎𝑏𝑙𝑒 𝐶𝑜𝑠𝑡 𝑃𝑒𝑟 𝑈𝑛𝑖𝑡 ∗ 𝑈𝑛𝑖𝑡𝑠

𝑈𝑛𝑖𝑡𝑠
 +  

𝐹𝑖𝑥𝑒𝑑 𝐶𝑜𝑠𝑡𝑠

𝑈𝑛𝑖𝑡𝑠
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Price Breakeven Table Exercise Part 1: Building the New Model 
Our first step is to adjust our spreadsheet as follows: 

 Set Units to any constant we desire (50 for example). 

 Set Price to our breakeven equation for Price. 
 
1. Make a copy of the "Breakeven_GoalSeek" sheet: 

 
 
 
 

 
2. Rename the new sheet to "Breakeven_Prices " by double 

clicking the tab's name, typing the new name, and pressing 
enter. 

 

 
 

 
 
 
3. Type any positive number (greater than zero) for Units Sold (B6).  Price (B5) should instantly show you the price you 

need to charge to breakeven for the number of units entered.   
 
Now that we have created a model that allows us to type in different Units and always returns Prices that keeps Profit at 
zero, we can create a one variable data table.  We will give it a list of different possible Units and it will return breakeven 
prices for those units.  See the next page on how to structure a one-variable data table. 
 
 
 
 
 

Hold down the Control key and drag 
the sheet's tab to the right to copy it. 

3. In B5 (Price) type: 
=B8+(B10/B6) 

 
 i.e. Cost Per Unit + (Fixed 

Costs / Units Sold) 

4. In B6 (Units Sold) type: 100 

5. In B12 (Profit) type: 0   
(Or type = B7-B11.  We 
removed any reference to 
B12 from other equations so 
it doesn't really matter what 
is here.) 
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Structure of a One Variable Data Table 

 
Excel's One Variable and Two Variable Data Tables allow you to produce a table of results by varying one or two of a 
calculation's inputs.  For example, if we provide a list of different Units, a One Variable Data Tables can produce the 
Breakeven Price for each unit.  Data Tables require a very specific structure to be used correctly.  The structure of a one 
variable data table is shown below. 
 

 
Note that for this to work, there must be a mathematical relationship between Units and Price.  For example, if manually 
typing different units in B6 does not change price (B5) then a One Variable Data Table can't help you.  All the data table 
is really doing is substituting each variable one by one into B6 to produce a table of different prices for each unit 
substituted in. 
 
 
(See the next page for Price Breakeven Table Exercise Part 2: Using the One Variable Data Table) 
 
 
 
 
 
 
 
 
 
 
 
 

Formula Whose Results You wish to Generate 
This cell must contain either the formula whose results you wish to display or a link to the cell containing the 
formula whose results you wish to display.  
In this example, we wish to produce different Prices based on Units sold.  Our calculation to get the Breakeven 
Price is =B8+(B10/B6)  and is in B5.  So, the area indicated (Formula to Test) either needs to repeat that formula 
or reference B5 (i.e. =B5). 

(Optional) Use these 
columns to test other 
formulas.  For example, 
"Revenue" also changes 
as we change Units Sold 
so we could also output a 
list of revenues. 

Variable List 
This is a list of the 
different values 
you wish to 
substitute into the 
formula. 
In this example the 
area will contain 
Units.  Each one of 
these values will be 
substituted into 
the "Formula to 
Test" one by one to 
produce the 
results. 

This is where the 
results of the 
formula will appear. 
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Price Breakeven Table Exercise Part 2: Using the One Variable Data Table 
We will now create a table of breakeven Prices given a series of Units. 
 
1. On the "Breakeven_Prices" tab, create the structure shown in columns D & E. 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3. In D6:D15, type the 
units you would like 
to find breakeven 
Prices for. 

 (These are our 
column variables 
and will be 
substituted into B6 
one at a time to 
produce our table of 
prices.) 

4. Highlight the range 
D5:E15 as indicated. 

5. From the menu, click the 
"Data" tab then "What-If 
Analysis" then "Data 
Table…". 

2. In E5 type:  =B5 
(This is the formula 
used to generate 
our prices.) 
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This is a One-Variable Data Table so we only have a Column Input Cell.  Row Input Cell will be left blank.  The Column 
Input Cell is the cell that you want your column of variables (i.e. "Units") to be substituted into to generate the prices.  In 
this case, we wish to substitute our column of UNITS (D6:D15) into cell B6. 
 

 
 
 
 
 
 
 
 
 

 
Excel should produce a column of breakeven prices for each corresponding unit. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Select B6 (Units Sold) as 
the "Column Input Cell". 

7. Click "OK". 
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Breakeven Exercise Part 3:  Display Prices and Revenues 
A one variable data table can display the results for more than one formula as long as both formulas are affected by the 
same variable.   We will modify our data table to also include Revenues. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Highlight D3:F15. 
3. From the menu, click the "Data" tab then "What-If Analysis" – "Data Table…". 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

1. In F5 type:   =B7 
 

(B7 contains the formula for Revenue.  
Referencing it here tells the table to 
generate results for Revenue for the 
various Units.) 

4. Set the "Column Input 
Cell" to B6. 

5. Click "OK". 

Excel should have also produced a column of revenues 
that correspond to the number of units being sold. 



Marshall School of Business - USC Excel_BreakEven_Analysis.docx  Wayne Wilmeth 4/10/14 Page 11 of 19 

Optional Exercise: Find Breakeven Units when Prices Vary 

In our previous data table exercise, we varied units to produce a series of breakeven prices.  You can also vary prices to 
see what your breakeven units will be.   
 

1. Copy the previous exercise to a new sheet and name the new sheet "Breakeven_Units". 
2. Make the edits shown below. 

 
 

 
 

 
 
 
 
 
 
 
 

 
7. Highlight D5:E15 
8. From the menu click the "Data" tab and then click "What-If Analysis" – "Data Table". 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. In B5 type a 
constant price 
such as 25 

5. In B6 type our breakeven 
formula for Units:  
=B10/(B5-B8) 

4. In E5 type =B6 

6. Type the prices 
shown. 

9. Set the Column Input 
Cell to B5. 

10. Click "OK". 

Excel should 
produce a 
table of 
breakeven 
units for the 
various 
prices given. 
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Exercise: Adjust Costs as Units change with VLookup() 

 
In our previous examples, varied Units Sold to see what our 
breakeven prices would be.  In our equations, Cost Per Unit was held 
constant at $15 and Fixed Cost was held constant at $2000 regardless 
of the number of units sold.  In reality however, both of these 
numbers would probably change as volume changes. 
 

Cost Per Unit  
As units increase, this cost will probably go down as you realize 
economies of scale.  For example, your suppliers of raw materials 
might give you price breaks when you purchase in greater volume. 
Fixed Costs 
Fixed costs include things that don't change as production changes.  
For example, mortgage payments, lease payments, salaries, etc.  
However, for the purpose of our model, once units hits a certain 
point, will have to purchase or lease more buildings and hire more 
employees so for our model, Fixed Costs will go up as Units increase.  
 

1. Go to the "Breakeven_Prices" sheet. 
2. Type the data shown in H3:J13  

 
 
 
 
 
 
 
 
 
 
 
 

This is the table we will use to lookup the Cost Per Unit and Fixed Costs associated with the number of 
Units sold.  (We are assuming we sell everything we make.)   
Vlookup() will look for the units we give it in the "Units" column.  When selecting the bracket, Vlookup() 
grabs the largest value it finds in the Units column that is less than or equal to what we are looking for.  
For example: 

 If we are looking for 9,000 units, 5,000 is the largest number in the Units column that is less than or 
equal to 9,000 so it will use the costs in row 6 (14.25 and 2000).   

 If we are looking for 50 units, 1 is the largest number in the Units column that is less than or equal 
to 50 so it will use the costs in row 4 (15 and 2000).   

When using Vlookup(), you must construct your table with how vlookup() searches in mind.  
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5. Try typing different Units in B6 to test your Vlookup()s.  Cost Per Unit and Fixed Costs should update accordingly. 
6. Regenerate your One Variable Data Table to output the new breakeven prices. 
 
 

How Vlookup() Works 
Vlookup() allows you to return data that is associated with a lookup value.  In this 
example we searched our table for Units Sold (Lookup Value) and returned the Cost 
Per Unit and Fixed Costs associated with the units we were looking for.    
 
 
 
 
The syntax of Vlookup() is as follows. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. In B8 type: 
 =Vlookup(B6,H4:J13,2,True) 

4. In B10 type: 
 =Vlookup(B6,H4:J13,3,True) 

Col #1 Col #2 Col #3 

Lo
o

ku
p

 V
a

lu
e 

It
em

 t
o

 R
et

u
rn

 

It
em

 t
o

 R
et

u
rn

 

The Lookup value must be to the left of the item you are 
returning and for approximate matches they must be sorted. 

=Vlookup(Lookup Value, Table to Search, Item to Return by Column #, Match Type) 

This is the value you wish to 
search by.  In this example, 
we searched by Units Sold.  
Your lookup value must be 
to the left of what you are 
returning. 

This is the range of the table 
you are searching.  It must 
include the column of your 
lookup values and the values 
you are returning.  In this 
example it is H4:J13 

This is the column number 
(counting within the table 
from left to right) containing 
the value associated with the 
item you are looking for. In 
this example, to return Cost 
Per Unit we put a 2; to return 
Fixed Costs we put a 3.  

Match Type is either True or False and specifies whether you want an exact match (False) or an 
approximate match (True).  Use an exact match (False) when searching by ID numbers or names.  
Use approximate match (True) when working with number ranges.  Approximate match finds the 
largest number that is less than or equal to what you are looking for.  
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Creating a Break Even Chart (Excel 2013) 

 
Graphically, breakeven occurs when Total Costs intersects 
Revenue.  In the image to the right, we are holding Price 
constant at $20 and plotting Fixed Costs, Total Costs, and 
Revenue.  As indicated by the graph, breakeven occurs at 
400 Units.  At this point, both Total Cost and Revenue are 
$8,000. 
 
We will create the chart as follows: 

A. Use a One-Variable Data Table to generate Total 
Costs and Revenues when holding price constant at 
$20 and varying Units. 

B. Create an XY Scatter Chart to display the lines. 
C. Create a 4th series that consists of a single data 

point (Breakeven). 
 
 

Part A: Create the Data for the Graph 
1. Create the spreadsheet shown below (or copy the "Breakeven_GoalSeek" sheet we created earlier).  
 It simply calculates what Profit, Revenue, Variable Costs and Total Costs would be if you vary Price or Units. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

Type 
formulas 
where 
indicated; 
other values 
are constants.  
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2. Create what is shown in columns E through H.  This is to generate values for our one variable data table. 
 (All values are static except for the two formulas indicated in F5 and G5.) 

 
3. To generate the One-Variable Data Table, follow the steps below: 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

These are 
static 
numbers.  

These are 
static 
numbers.  

3a. Highlight the range   
E5:G16 

3b. Click "Data" then "What-If 
Analysis" then "Data Table. 

3c. Set the "Column input cell" 
to $B$6 then click "OK". 
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Part B: Create an XY Scatter Chart to Display the Lines 
When highlighting to create an XY Scatter Chart as we are doing below, Excel will assume that the left most column is for 
all X data points for all lines.  The multiple columns to the right will each be a separate line and contain the Y data points. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

These values should have 
been generated.  Note that 
they will update if you 
change Price (B5).   

1. Highlight E4:H4 
 (These will become our legend). 

2. Hold down the Control key on your 
keyboard and highlight E6:H6 

 (These will become our data points). 

3. From the menu click "Insert" then "XY 
Scatter" then "Scatter with Straight 
Lines". 

You should now have a XY 
Scatter chart similar to the 
one shown here.  Note that 
if you change Price (B5), the 
date table and the chart will 
update. 
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Part C: Marking the Breakeven Point 
We wish to mark the breakeven point on our chart.  We 
could use Excel's drawing tools to annotate it but that would 
not update should we change the price we are charging.  
Instead, we will add a 4th series that contains just one data 
point.  To make the data point dynamic, we will base its X 
value on the breakeven calculation for Units: 
 
 BE Units = Fixed Costs / (Price –Variable Cost)  
 
To get the corresponding Y value: 

BE Units * Price 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 

1. In B14 type:   =B10/(B5-B8) 
2. In B15 type:  =B5*B14 

5. Click the "Add" button to 
add a 4th series to the chart. 

3. Click your chart to make the chart tools appear on the menu. 
4. Click the "Design" tab then the "Select Data" button. 

6. Set the "Series X Values" 
to cell B14. 

7. Set the "Series Y Values" 
to cell B15. 

8. Click "OK". 
9. Click "OK" again. 
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You may have noticed that the data point is not visible on your chart.  We must now give it 
some color. 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

10. Click the chart to activate the Chart Tools. 
11. Click the "Format" tab under Chart Tools. 
12. Click the "Chart Elements" drop down (located in the upper left). 
13. Select "Series 4" from the list of chart elements. 

Your Series 4 data point 
should now be selected. 

14. Click "Format Selection". 

15. Click "Line & Fill". 

16. Click "Marker". 

17. Expand "Marker Options". 
 a. Select "Built-in" 
 b. Specify a "Type" and "Size". 

18. Expand "Fill". 
 a. Select "Solid Fill" 
 b. Specify a "Color"  

19. Expand "Border". 
 a. Select "No Line".  

20. Select "Series4" 
in the legend 
and press your 
delete key.  
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21. To label the Breakeven point: 
 a. Right click the data point. 
 b. Click "Add Data Labels". 
 c. Click "Add Data Callouts". 
  

21. Change the "Price" in cell B5 and the 
chart should adjust accordingly. (Note 
that changing Units Sold has no effect 
on our chart.  It was designed to only be 
affected by changes in Price.) 


